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Date: 20-06-2022
To

Dr.P.Surendra Kumar,
Associate Professor, Bapatla Engineering College,
Bapatla.

Dear Sir,

Subject: Inviting for Certificate program “Antenna Design using HFSS”- Reg.

Greetings from RISE Krishna Sai Gandhi Group of Institutions, Ongole

As per the discussion with Dr.K.V.Subrahmanyam , Principal, of our Institute, I hereby
take this opportunity to invite you to conduct the Certificate program on Antenna Design using
HFSS “ From 11-07-2022 to 15-07-2022.

You are requested to interact and provide guidance to our IV B.Tech students, who are
looking forward to their bright career ahead. I will feel honored by your gracious presence at our

organization. I believe that your lecture will help our students and faculty members to explore
knowledge.

Thanking you in anticipation.

Yours sincerely,

PRINCIPAL
RISE KRISHNA SA} GAMD .
GROUP OF INSTITHTIONS

VALLUEL OHGOLE,



Dr. P. Surendrakumar

Associate Professor

ECE

Bapatla Engineering College, Bapatla.
Email: mailme_surendranitk@yahoo.co.in

Biography

Dr. P. Surendra Kumar, received his B.Tech degree from V.R. Siddhardha Engineering College,
Vijayawada and M.Tech in Digital Electronics and Advanced communications (DEAC) from
National Institute of Technology (NIT) Surathkal Karnataka in the Department of Electronics and
Communication Engineering, received Ph.D. in Microstrip antenna design from Nagarjuna
University, Guntur, (AP) He has 15 years of teaching experience as an Associate professor in
Bapatla Engineering College, Bapatla. His areas of interests are Microstrip Antenna design, MIMO
antenna and antenna design for 5G and 6G wireless applications. He has published 30+ research
papers in top journals and conferences.
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Received 1*' Best Research paper award from IEEE Hyderabad section (InCAP2018).

. Received 39 Best Research paper award from I1Sc Bangalore, INDICON2016.

Received Best Young Researcher Award from Global Education (GECL2k19).

- Nominated for Young Scientist Award-2018 from innovative research developers.

. Reviewer for SCI Journal (International Journal of RF and Microwave Computer-Aided

Engineering, John Wiley & Sons Periodicals, Impact factor:1 .306).
Published research papers in IISc Bangalore, IIT Roorkee and IIT Bhubaneswar.
Published IEEE SCI journal research papers in [EEE Antennas and Propagation.

. Reviewer for IEEE International Conference.

- Received UGC Minor research project of worth 2.3 Lakhs.

10. Reviewer for IEEE Access.

Selected Publications: latest 5 publications

l.

P. Surendrakumar, “Miniaturization of patch antenna using partially loaded non-uniform
meta-surfaces with metamaterial,” IEEE Antennas and Propagation Magazine, Vol.61,
Issue. 01, Feb 2019.

P. Surendrakumar, “Design of Triple Frequency Vertex Feed Pentagonal slot antenna with
E-slot for WiMAX and WLAN Applications,” IEEE Antennas and Propagation
Magazine, Vol.60, Issue. 03, June2018.

P. Surendrakumar, Triple-UWB Millimeter-wave MIMO Antenna with Improved
Isolation for 5G Wireless Applications, IEEE Indian conference on Antennas and
Propagation 2019, Dec21.

. P. Surendrakumar, A Compact Hexa-Band and UWB Antenna Using Heptagon and

Nonagon Rings with Vertex Feed, IEEE Indian Conference on Antennas and
Propagation, Dec 2018.

- P. Surendrakumar, “Design of a Miniaturized triple-band antenna with conductor backed

metasurfaces CPW-fed for 5G Wireless applic
IEEE section, IEEE Bangalore, Dec 2017

Page 1 of 1



Rle KRISHNA SAI GANDHI GROUP OF INSTITUTIONS
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PROPOSAL FORM

SUB: Certificate program.

TO THE SECRETARY/CORRESPONDENT THROUGH PRINCIPAL FOR KIND

APPROVAL
1 NAME OF THE INSTITUTION Rise Krishna Sai Gandhi Group of Institutions
2 NAME OF THE DEPARTMENT Electronics & Communication Engineering
3 | TITLE OF THE PROGRAMME Centicasiprogiam
4 NAME OF THE PROGRAMME Certificate program on “ Antenna Design using
e HFSS ”
5 OBJECTIVE OF THE PROGRAMME | To bring the exposure in the Antenna Design.
Dr.P.Surendra Kumar,
6 DETAILS OF RESOURCE Associate Professor, Bapatla Engincering College,
PERSON(S)& CV ATTACHED. Bapatla.
7 PROPOSED DATE(S)YACADEMIC L1-07-2022 to 15-07-2022
YEAR
8 DURATION OF THE PROGRAMME | FIVE DAY
9 VENUE MPMC Lab
10 | TARGETS IV ECE students
11 No. OF PARTICIPANTS 63 Students
12 | REGISTRATION FEE Free
NAME OF PROGRAMME CO .
13 ORDINATOR(S) Mr. R.V Kiran Kumar
14 NAME OF THE STUDENTS 1.Ms. Parimi Surekha ( 198B1A0425)
COORDINATOR(S) 2.Mr. Kunchala Ashok ( 198B1A0448)

NoT.
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15 SOURCE OF FUND IDENTIFIED Management
16 MANAGEMENT CONTRIBUTION YES
REQUIRED
17 PROPOSAL PREPARED BY Mr. R.V Kiran Kumar (CO-ORDINATOR)
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RISE KRISHNA SAI GANDHI GROUP OF INSTITUTIONS
(Approved by AICTE,New Delhi & Affiliated to INTUK,Kakinada)
NH-16, Valluru, Ongole, Prakasam (District)-523272
Department of Electronics and Communication Engineering

Vallury,
Date: 09-07-2022.

CIRCULAR

This is to inform IV B.Tech students and faculty that there will be a 5-Day Certificate
program on“Antenna Design using HFSS”from 11-07-2022 to 15-07-2022by Dr.P.Surendra

Kumar, Associate Professor, Bapatla Engineering College,Bapatla.

S.V.%; M

HEAD OF THE DEPARTMENT
Copy to: Department of ECE
RISE Krishna Sai Gandhi Group
Enncipal ¢ <fitutions VALLURUAP.523 272
Staff Circular
Students of ECE IV year

ECE Department Notice Boards



T

=
£ Adaw 3
v Ay

(Approved by AICTE,New Delhi & Affiliated to INTUK,Kakinada)
NH-16, Valluru, Ongole, Prakasam (District)-523272
Department of Electronics and Communication Engineering

%, RISE KRISHNA SAI GANDHI GROUP OF INSTITUTIONS

Certificate Program on “Antenna Design using HFSS”

Date: 11%to 15™July 2022

SCHEDULE FROM 11-07-2022 TO 15-07-2022

S.No Program List Timing
From To
DAY - 01 (11-07-2022)
1 Program started 09.00 AM --
2 Lamp lighting 09.00 AM 09.10 AM
3 Principal speech 09.10 AM 09.25 AM
4 HOD Introduction about Antenna Design 09.25 AM 09.35 AM
5 Tea Break 09.35 AM 10.00 AM
6 Introduction to Antennas 10.00 AM 01.00 PM
7 Lunch Break 01.00 PM 01.45 PM
8 Antenna Architecture , 01.45 PM 05.00 PM
DAY - 02 (12-07-2022)
9 Introduction to HFSS 09.00 AM 12.15 PM
10 | Lunch Break 12.15 PM 01.00 PM
11 | Antenna Parameters 01.00 PM 05.00 PM
DAY - 03 (13-07-2022)
12 | Importance of HFSS with other tools 09.00 AM 12.15PM
13 | Lunch Break 12.15 PM 01.00 PM
14 | Antenna Designing Mathematical 01.00 PM 05.00 PM
Calculations
DAY - 04 (14-07-2022)
15 | Antenna Designing Procedures 09.00 AM 12.15PM
16 | Lunch Break 12.15 PM 01.00 PM
17 | Di-Pole Antenna Design in HFSS 01.00 PM 05.00 PM
DAY - 05 (15-07-2022)
18 | Result Analysis 09.00 AM 12.15PM
19 | Lunch Break 12.15PM 01.00 PM
20 | Some Sample Antenna Designs 01.00 PM 04.15 PM
21 | Certificate Program Exam 04.15 PM 04.45 PM
22 | Vote of Thanks 04.45 PM 05.00PM |

Co@ifiator

RISE
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RISE KRISHNA SAl GANDHI GROUP OF INSTITUTIONS:: ONGOLE
DEPARTMENT A% ELECTRONICS AND COMMUNICATION ENGINE_ERING

Student Feedback Form

Name of the Student: pevamrr;:aﬁ’ vistal?

Roll No

F198BlADY [

Topic : Certificate Program on ""Antenna Design using HFSS"

73; s

5
i3 e

s

Date: 15-07-2022

S.No

Feedback Points

Is the certification program useful or not ?

Is the certification program well planned or not?

Lecture makes objectives clear?

Lecture speaks clearly and audibly?

Lecture explains with exaples clearly?

R

Is you are doubts clarified or not?

1
2
3
4
5
6
-E

5

xcellent

4-Good

v’

3-Average 2-Poor

o

1- No comment

Jﬂ}de\r{ﬁg ign e'lture
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RISE KRISHNA SAI GANDHI GROUP OF INSTITUTIONS:: ONGOLE
DEPARTMEI\{%‘ OF ELECTRONICS AND COMMUNICATION ENGJ*'EERING
Student Feedback Form
Name of the Student: Mm/;’kanoé:\ Parokrishna
Roll No : 1q83lAousYy
Topic : Certificate Program on ""Antenna Design using HFSS"' Date: 15-07-2022
( .
| S.No Feedback Points 5 4 3 2 1
1 |Is the certification program useful or not ? v
2 |Is the certification program well planned or not? ~
3 |Lecture makes objectives clear? v~
4 |Lecture speaks clearly and audibly?
5 |Lecture explains with exaples clearly? v
6 |Is you are doubts clarified or not? v
5-Excellent 4-Good 3-Average 2-Poor 1- No comment
Milghid-
tudent Signaturt
%
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il
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RISE KRISHNA SAI GANDHI GROUP OF INSTITUTIONS:: ONGOLE
DEPARTMENT OF ELECTRONICS AND COMMUNICATION ENGINEERING

Student Feedback Form

Name of the Student: %DU'/: Hhartkrichno
Roll No © [agBlAoUYD
Topic : Certificate Program on '""Antenna Design using HFSS" Date: 15-07-2022
S.No Feedback Points 5 4 3 2 1

1 |Is the certification program useful or not ? v

2 |Is the certification program well planned or not? Ng

3 |Lecture makes objectives clear? v’

4 |Lecture speaks clearly and audibly? v

5 |Lecture explains with exaples clearly? v©

6 |Is you are doubts clarified or not? v
5-Excellent 4-Good 3-Average 2-Poor 1- No comment
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( RISE KRISHNA SAI GANDHI GROUP OF INSTITUTIONS:: ONGOLE
DEPARTMENT OF ELECTRONICS AND COMMUNICATION ENGINEERING
- Student Feedback Form
Name of the Student: l:n#w*rn 746/7?0704
Roll No ' 1Q8BADYR 4
Topic : Certificate Program on " Antenna Design using HFSS" Date: 15-07-2022
S.No Feedback Points 5 4 3 2 1
1 |Is the certification program useful or not ? v
2 |Is the certification program well planned or not? T
3 |Lecture makes vbjectives clear? v
4 |Lecture speaks clearly and audibly? v’
: S5 |Lecture explains with exaples clearly? v'
(
s 6 {Is you are doubts clarified or not? 2
5-Excellent 4-Good 3-Average 2-Poor 1- No comment
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RISE KRISHNA SAI GANDHI GROUP OF INSTITUTIONS:: ONGOLE

DEPARTMENT OF ELECTRONICS AND COMMUNICATION ENGINEERING
CERTIFICATE PROGRAM FEEDBACK ANALYSIS

Year : IV B.Tech ECE
Name of the Certificate Program: Antenna Design using HFSS

Date: 15-07-2022

S.No| Reoll Number Name 1 2 3 4 5 6
1 198B1A0401 |APPALA DURGA MAHALAKSHMI 5 4 4 4 4 5
2 198B1A0402 |BANDARU DHARANI 5 5 5 5 S 5
3 198B1A0404 |BOGALA CHINNAKKA 4 5 4 5 4 5
4 198B1A0405 |CHALLA THRIVENI 5 4 4 4 5 5
5 198B1A0406 |CHANDA VIJAYA DURGA 5 3 5 5 5 5
6 198B1A0407 |CHANDRA UMARANI 5 5 5 5 3 5
7 198B1A0408 |CHEMBETI VASANTHI 5 5 5 5 5 5
8 198B1A0410 |DANDIBOYINA SRAVANI 5 5 5 5 5 4
9 198B1A0412 |DEVARAMPATI VISHALI 5 5 5 5 5 4
10 198B1A0413 |DEVATHA NAGAJYOTHI 5 4 S 4 5 5
11 198B1A0414 |DUDDIKUNTA JYOTHI REDDY 5 5 5 4 5 4
12 198B1A0415 |DUMPA SANDHYA 5 5 5 5 5 5
13 198B1A0416 |EEMANI SWAPNA 5 4 5 5 5 5
14 198B1A0417 |JAMPANI HARI VANDANA 5 5 5 5 5 5
15 198B1A0418 |FYOSHNA VAKA 5 5 4 5 5 5
16 198B1A0419 |KONDURI SANTHOSHI POORNIMA ‘__-_______________75 5 4 5 4 4
17 198B1A0420 |[KOTA YAMINI / | 5 5 S5 4 5 4

N
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S.No| Rell Number Name 1 3 4 5 6
18 198B1A0421 |MADIREDDY ANUSHA 5 4 5 4 4
19 198B1A0422 |MANDAPATI SAIPREETH! 5 5 4 4 5
20 198B1A0424 |PADARTHI VENKATA SAI AKHILA 5 5 4 5 5
21 198B1A0425 |PARIMI SUREKHA 5 5 5 4 5
22 198B1A0426 |PATHURI ABHINAYA 4 5 4 5 5
23 198B1A0427 |PUNUGOTI BHULAKSHMI 5 4 4 5 3
24 198B1A0428 |RAVURILAKSHMI 5 4 5 5 5
25 198B1A0429 |SHAIK HUZURUNNISA 5 4 5 5 5
26 198B1A0430 |[SHAIK RUKHYA 5 5 4 4 5
27 198B1A0431 |TAMALAPAKULA KAVITHA RANI 4 4 5 5 5
28 198B1A0432 |THATI THOTI PARIMALA 5 4 5 5 4
29 198B1A0433 |VADLAMUDI DEEPTHI 5 5 5 5 5
30 198B1A0434 |VEMULA MOUNIKA 5 4 5 4 4
31 198B1A0436 |ANUMOLU MANIDEEP 4 4 5 5 5
32 198B1A0437 |BELLAMKONDA DANAMURTHI 5 5 5 4 5
33 198B1A0439 |CHITIRALA VISHNU VARDHAN 4 4 5 5 5
34 198B1A0440 |DEPURI HARIKRISHNA 5 4 4 5 5
35 198B1A0441 |EDAMAKANTIRAVI 5 4 4 5 4
36 198B1A0442 |GONUGUNTA HARIBABU 5 4 5 4 4
37 198B1A0443 |GONUGUNTA MAHESH 4 4 5 5 5
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S.No| Roll Number Name 1 2 3 6
38 198B1A0444 |KANDLAGUNTA NAVEEN KUMAR 5 4 4 5
39 198B1A0445 |KASU DURGA RAJESWAR REDDY 4 5 4 5
40 198B1A0447 |KESAMREDDY PRABHAKAR S 4 5 5
4] 198B1A0448 |KUNCHALA ASHOK 5 5 4 3
42 198B1A0449 |KUNCHALA HARESH 5 4 4 5
43 198B1A0450 |MADALA AMARNADH 4 5 4 5
44 198B1A0451 |MADDULURI SIVA SAI KUMAR 5 S 5 5
45 198B1A0452 |MAMILLAPALLI SUMANTH KUMAR 4 5 4 5
46 198B1A0453 |MANNEM MAHESH 4 4 4 4
47 198B1A0454 |MEDIKONDA RAMAKRISHNA 5 4 4 4
48 198B1A0455 |MOLABANTINAGA SRINU 4 5 5 5
49 198B1A0456 |MUNAGALA CHARAN REDDY 4 5 5 4
50 198B1A0457 {PAMBA ANJAIAH 4 4 5 5
51 198B1A0458 |RAVULAPALLI CHARAN KUMAR 5 4 5 4
52 198B1A0459 |RENUMALA NAGAMUTTHU 5 4 5 4
53 198B1A0460 |SHAIK AZMAL 4 4 4 5
54 198B1A0461 [SHAIK SHAJAHAN 5 5 5 5
55 198B1A0462 |TELUKUTLA GOPI 4 5 5 5
56 198B1A0463 |THANNIRU DURGA MALLESHWAR 5 5 5 5
57 198B1A0464 |VADDEMPUDIREVANTH 4 5 5 5

AT
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S.No| Roll Number Name 1 2 3 4 5 6
58 198B1A0465 |PULI JAYARAMIREDDY 5 4 5 5 4 4
59 208B5A0401 |KUNCHALA AKHILA 4 5 5 4 5
60 208B5A0402 |POTU SRI MOUNIKA 5 4 5 35 5 5
61 208B5A0403 |SYED TASNIMKAUSAR 4 S 5 4 5 5
62 208B5A0404 |VENNAPUSA ESWAR REDDY 5 5 5 4 5 5
63 208B5A0406 |TANNIRU MANOJ KUMAR 5 5 4 4 5 5
466 | 467 | 453 | 4.61 | 4.75 4.77
93.13] 93.44 | 90.63|92.19| 95.00 | 95.31
S'\fr > &_?{
Coofginator i
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(Approved by AICTE, New Delhi & Affiliated to INTUK, Kakinada)
NH-16, Valluru, Ongole, Prakasam (District)-523272
Department of Electronics and Communication Engineering

Certificate program Feedback Analysis

: Certification program on” Antenna Design using HFSS”

Topic
Resource Person : Dr.P.Surendra Kumar,
Associate Professor, Bapatla Engineering College, Bapatla.
Dates : 11-07-2022 to 15-07-2022
Venue : MPMC Lab

Targeted Students . IV Year students

No. of students No. of students =
s Participated given feedback MG T
| 63 63 100%

sn«-ﬁisﬁﬁk <%?—z‘(
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Department of LCE
RISE Krishna Sai Gandhi Group
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s RISE KRISHNA SAI GANDHI GROUP OF INSTITUTIONS

(Approved by AICTE,New Delhi & Affiliated to INTUK Kakinada)
NH-16, Valluru, Ongole, Prakasam (District)-523272
Department of Electronics and Communication Engineering

Certificate Program on Antenna Design using HFSS
Model Question Paper

Branch/Sem: IV ECE/l SEM
Name of the Student: ROLL Number:

1. The radiation efficiency of an antenna is a measure of
a) How well it radiates

b) How well it receives signals

c) The losses in the antenna system

d) The bandwidth of the antenna [ 1]

2. HFSS can simulate the coupling between different antennas in an array using
analysis.

a) Near-field

b) Far-field

¢) Mutual

d) Self [ ]

3. The term "substrate' in the context of antenna design refers to

a) The conductive material of the antenna

b) The dielectric material on which the antenna is mounted

c) The length of the antenna elements

d) The frequency of operation [ 1]

4. HFSS can analyze the effect of on antenna performance.

a) Temperature

b) Humidity

¢) Wind speed

d) All of the above [ ]

5. The design of a microstrip patch antenna involves specifying the dimensions of
the

a) Ground plane

b) Substrate

¢) Patch

d) All of the above [ ]

6. The term "gain" in antenna design refers to

a) The ability of an antenna to concentrate radiation in a partlcular direction

b) The total power radiated by the antenna

c) The frequency response of the antenna

d) The impedance matching of the antenna [ ]
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7. HFSS can simulate the effect of on the performance of a phased
array antenna.

a) Beamforming

b) Polarization

c) Frequency

d) All of the above [ 1

8. The ""Smith chart" is a graphical tool used in HFSS for

a) Analyzing transmission lines

b) Visualizing impedance matching

¢) Studying polarization

d) All of the above [ ]

9. In HFSS, the ""boundary" conditions are used to specify the behavior of
electromagnetic fields at the of the simulation domain.

a) Interior

b) Exterior

c) Center

d) Edges [ 1]

10. HFSS can simulate the effect of on the performance of an
antenna.

a) External objects

b) Surrounding structures

c¢) Nearby antennas

d) All of the above [

11. The term "impedance matching' in antenna design refers to

a) Matching the antenna's impedance to the transmission line

b) Matching the antenna's impedance to free space

¢) Adjusting the frequency of operation

d)Bothaand b [ ]

12. The "Q factor' in antenna design is a measure of the antenna's

a) Resonance

b) Bandwidth

c) Efficiency

d) Polarization [ ]

13. HFSS can simulate the effect of on the performance of a
microstrip antenna.

a) Substrate thickness

b) Feed location

c) Patch shape

d) All of the above [ ]
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14. The "Smith chart" is particularly useful for designing .

a) Log-periodic antennas

b) Yagi-Uda antennas

¢) Matching networks

d) Dipole antennas [1]

15. HFSS can analyze antennas for different types of

a) Materials

b) Polarizations

¢) Transmission lines

d) Connectors [ 1]

16. The term "near-field" in antenna design refers to the region

a) Close to the antenna where reactive fields dominate

b) Far from the antenna where radiative fields dominate

¢) Within the transmission line

d) At the edge of the simulation domain (]

17. HFSS can be used to optimize antenna designs based on criteria such as

a) Maximum gain

b) Minimum return loss

c) Desired radiation pattern

d) All of the above [ ]

18. The term "crosstalk" in antenna systems refers to

a) Unintended coupling between antennas

b) Transmission line losses

¢) Far-field radiation

d) Antenna impedance mismatch [ 1]

19. HFSS can simulate the effect of different on the performance of
an antenna.

a) Frequency bands

b) Feed structures

c¢) Radome materials

d) All of the above [ ]

20. The "VSWR'' (Voltage Standing Wave Ratio) is a measure of

a) Signal strength

b) Antenna gain

¢) Impedance matching quality

d) Far-field radiation pattern [ ]
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Answers:
. a) How well it radiates
. ¢) Mutual
. b) The dielectric material on which the antenna is mounted
. a) Temperature
. d) All of the above
. a) The ability of an antenna to concentrate radiation in a particular direction
. @) Beamforming
8. b) Visualizing impedance matching
9. d) Edges
10. d) All of the above
11.d)Bothaand b
12. b) Bandwidth
13. d) All of the above
14. c) Matching networks
15. b) Polarizations
16. a) Close to the antenna where reactive fields dominate
17. d) All of the above
18. a) Unintended coupling between antennas
19. d) All of the above
20. ¢) Impedance matching quality

NN R W -
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Certificate Program on Antenna Design using HFSS “ (‘
Model Question Paper ‘/

Branch/Sem: IV ECE/l SEM
Name of the Student: 3 othala chinnQikiko,  ROLL Number: 986 ouUoy

1. The radiation efficiency of an antenna is a measure of
a) How well it radiates
b) How well it receives signals

c) The losses in the antenna system

d) The bandwidth of the antenna qu/

2. HFSS can simulate the coupling between different antennas in an array using
analysis.

a) Near-field

b) Far-field

¢) Mutual

d) Self K

3. The term "'substrate" in the context of antenna design refers to

a) The conductive material of the antenna

b) The dielectric material on which the antenna is mounted

c¢) The length of the antenna elements

d) The frequency of operation [b]/

4. HFSS can analyze the effect of on antenna performance.
a) Temperature

b) Humidity

¢) Wind speed

d) All of the above [9]/

5. The design of a microstrip patch antenna involves specifying the dimensions of
the

a) Ground plane
b) Substrate

¢) Patch

d) All of the above 13']/
6. The term "gain" in antenna design refers to

a) The ability of an antenna to concentrate radiation in a partlcular direction

b) The total power radiated by the antenna

¢) The frequency response of the antenna /
d) The impedance matching of the antenna 1A

QXS
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7. HFSS can simulate the effect of on the performance of a phased
array antenna.

a) Beamforming

b) Polarization

c) Frequency

d) All of the above [b]

8. The ""Smith chart" is a graphical tool used in HFSS for

a) Analyzing transmission lines

b) Visualizing impedance matching

¢) Studying polarization

d) All of the above (4

9. In HFSS, the "boundary" conditions are used to specify the behavior of
electromagnetic fields at the of the simulation domain.

a) Interior

b) Exterior

c¢) Center

d) Edges ECI]/

10. HFSS can simulate the effect of on the performance of an
antenna.

a) External objects

b) Surrounding structures

c¢) Nearby antennas

d) All of the above 9/

11. The term "impedance matching" in antenna design refers to
a) Matching the antenna's impedance to the transmission line

b) Matching the antenna's impedance to free space

¢) Adjusting the frequency of operation

d) Bothaand b

12. The "'Q factor" in antenna design is a measure of the antenna's
a) Resonance
b) Bandwidth
c) Efficiency

d) Polarization [ ‘[D)/ :

13. HFSS can simulate the effect of on the performance of a
microstrip antenna.

a) Substrate thickness

b) Feed location

c) Patch shape

d) All of the above [c]
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14. The ""Smith chart" is particularly useful for designing
a) Log-periodic antennas

b) Yagi-Uda antennas

¢).Matching networks

d) Dipole antennas b\y

15. HFSS can analyze antennas for different types of
a) Materials

b) Polarizations
¢) Transmission lines

d) Connectors ‘y‘o/-

16. The term "near-field" in antenna design refers to the region

a) Close to the antenna where reactive fields dominate

b) Far from the antenna where radiative fields dominate

c) Within the transmission line

d) At the edge of the simulation domain [@l

17. HFSS can be used to optimize antenna designs based on criteria such as

a) Maximum gain
b) Minimum return loss
¢) Desired radiation pattern

d) All of the above 2

18. The term "crosstalk" in antenna systems refers to

a) Unintended coupling between antennas

b) Transmission line losses

¢) Far-field radiation

d) Antenna impedance mismatch 1[9],

19. HFSS can simulate the effect of different on the performance of
an antenna.

a) Frequency bands

b) Feed structures

¢) Radome materials
d) All of the above [-eﬂ/
20. The "VSWR" (Voltage Standing Wave Ratio) is a measure of

a) Signal strength
b) Antenna gain

¢) Impedance matching quality g
d) Far-field radiation pattern LLd/
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1. The radiation efficiency of an antenna is a measure of
a) How well it radiates

b) How well it receives signals

c) The losses in the antenna system

d) The bandwidth of the antenna y/

2. HFSS can simulate the coupling between different antennas in an array using
analysis.

a) Near-field

b) Far-field

¢) Mutual

d) Self 9[9/ '

3. The term "substrate" in the context of antenna design refers to .
a) The conductive material of the antenna

b) The dielectric material on which the antenna is mounted

c) The length of the antenna elements

d) The frequency of operation )9
4. HFSS can analyze the effect of on antenna performance
a) Temperature

b) Humidity

¢) Wind speed
d) All of the above

5. The design of a microstrip patch antenna involves specifying the dimensions of
the

a) Ground plane

b) Substrate

¢) Patch

d) All of the above y/

6. The term "'gain" in antenna design refers to >

a) The ability of an antenna to concentrate radiation in a particular direction

b) The total power radiated by the antenna

¢) The frequency response of the antenna )
d) The impedance matching of the antenna }&—}/
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7. HFSS can simulate the effect of on the performance of a phased
array antenna.

a) Beamforming

b) Polarization

¢) Frequency

d) All of the above y]/

8. The ""Smith chart" is a graphical tool used in HFSS for
a) Analyzing transmission lines

b) Visualizing impedance matching

¢) Studying polarization

d) All of the above ‘[g/

9. In HFSS, the ""boundary" conditions are used to specify the behavior of
electromagnetic fields at the of the simulation domain.

a) Interior

b) Exterior

c) Center

d) Edges _@]/

10. HFSS can simulate the effect of on the performance of an
antenna.

a) External objects

b) Surrounding structures

c) Nearby antennas

d) All of the above y/f-
11. The term "impedance matching'' in antenna design refers to .
a) Matching the antenna's impedance to the transmission line
b) Matching the antenna's impedance to free space
|

c) Adjusting the frequency of operation

d) Bothaand b }/

12. The "Q factor' in antenna design is a measure of the antenna's
a) Resonance
b) Bandwidth

c) Efficiency

d) Polarization L}@/

13. HFSS can simulate the effect of on the performance of a
microstrip antenna.

a) Substrate thickness

b) Feed location

¢) Patch shape

d) All of the above )@/
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14. The "Smith chart" is particularly useful for designing
a) Log-periodic antennas

b) Yagi-Uda antennas

¢) Matching networks

d) Dipole antennas .ﬁj/

15. HFSS can analyze antennas for different types of
a) Materials

b) Polarizations

¢) Transmission lines

d) Connectors .[/@/

16. The term "near-field" in antenna design refers to the region

a) Close to the antenna where reactive fields dominate

b) Far from the antenna where radiative fields dominate

¢) Within the transmission line

d) At the edge of the simulation domain \Q@]/

17. HFSS can be used to optimize antenna designs based on criteria such as

a) Maximum gain
b) Minimum return loss
¢) Desired radiation pattern

d) All of the above yf

18. The term "crosstalk" in antenna systems refers to
a) Unintended coupling between antennas

b) Transmission line losses

c) Far-field radiation

d) Antenna impedance mismatch '/[A'j/
19. HFSS can simulate the effect of different on the performance of
an antenna.

a) Frequency bands

b) Feed structures

c) Radome materials

d) All of the above V[’ﬁ

20. The "VSWR" (Voltage Standing Wave Ratio) is a measure of
a) Signal strength

b) Antenna gain

c¢) Impedance matching quality

d) Far-field radiation pattern VPQ/

e sz

VAL



(Approved by AICTE, New Delhi & Affiliated to JINTUK, Kakinada)
NH-16, Valluru, Ongole, Prakasam (District)-523272
Department of Electronics and Communication Engineering

Certificate Program on Antenna Design using HFSS Marks

AY-:2022-2023 Year: IV
S. No Reg. No Name of the Candidate Marks

1 198B1A0401 | APPALA DURGA MAHALAKSHMI 18
2 198B1A0402 | BANDARU DHARANI 18
3 198B1A0404 | BOGALA CHINNAKKA 7
4 198B1A0405 | CHALLA THRIVENI 19
5 198B1A0406 | CHANDA VIJAYA DURGA 20
6 198B1A0407 | CHANDRA UMARANI 20
7 198B1A0408 | CHEMBETI VASANTHI 16
8 19881A0410 | DANDIBOYINA SRAVANI 19
9 198B1A0412 | DEVARAMPATI VISHALI 16
10 198B1A0413 | DEVATHA NAGAJYOTHI 20
11 198B1A0414 | DUDDIKUNTA JYOTHI REDDY 19

|12 | 198B1A0415 | DUMPA SANDHYA 16
13 | 198B1A0416 | EEMANI SWAPNA 19
14 198B1A0417 | JAMPANI HARI VANDANA 19
15 198B1A0418 | JYOSHNA VAKA 20
16 198B1A0419 | KONDURI SANTHOSHI POORNIMA 17
17 198B1A0420 | KOTA YAMINI 18
18 198B1A0421 | MADIREDDY ANUSHA 17
19 198B1A0422 | MANDAPATI SAI PREETHI 18
20 198B1A0424 | PADARTHI VENKATA SAI AKHILA 19
21 198B1A0425 | PARIMI SUREKHA 18
5] 198B1A0426 | PATHURI ABHINAYA 18
23 198B1A0427 | PUNUGOTI BHULAKSHMI 18
24 198B1A0428 | RAVURI LAKSHMI 18
25 198B1A0429 | SHAIK HUZURUNNISA 18
26 198B1A0430 | SHAIK RUKHYA 18
27 198B1A0431 | TAMALAPAKULA KAVITHA RANI 15
28 198B1A0432 | THATI THOTI PARIMALA 19
29 198B1A0433 | VADLAMUDI DEEPTHI 18
30 198B1A0434 | VEMULA MOUNIKA 19
31 198B1A0436 | ANUMOLU MANIDEEP 17
32 198B1A0437 | BELLAMKONDA DANAMURTHI 18
33 198B1A0439 | CHITIRALA VISHNU VARDHAN 18
34 198B1A0440 | DEPURI HARIKRISHNA 18

GR

VALLURU:: G

o=




% RISE KRISHNA SAT GANDHI GROUP OF INSTITUTIONS
) (Approved by AICTE, New Delhi & Affiliated to INTUK, Kakinada)

. NH-16, Valluru, Ongole, Prakasam (District)-523272

Department of Electronics and Communication Engineering

S. No Reg. No [ Name of the Candidate Marks
35 198B1A0441 | EDAMAKANTI RAVI 19
36 198B1A0442 | GONUGUNTA HARI BABU 18
37 198B1A0443 | GONUGUNTA MAHESH 19
38 198B1A0444 | KANDLAGUNTA NAVEEN KUMAR 17
39 198B1A0445 | KASU DURGA RAJESWAR REDDY 19
40 198B1A0447 | KESAMREDDY PRABHAKAR 16
41 198B1A0448 | KUNCHALA ASHOK 16
42 198B1A0449 | KUNCHALA HARESH 16

3 198B1A0450 | MADALA AMARNADH 17
44 198B1A0451 | MADDULURI SIVA SAI KUMAR 15
45 198B81A0452 | MAMILLAPALLI SUMANTH KUMAR 18
46 198B1A0453 | MANNEM MAHESH 17
47 198B1A0454 | MEDIKONDA RAMAKRISHNA 19
48 198B1A0455 | MOLABANTI NAGA SRINU 20
49 198B1A0456 | MUNAGALA CHARAN REDDY 20
50 198B1A0457 | PAMBA ANJAIAH 17
51 198B1A0458 | RAVULAPALLI CHARAN KUMAR 19
52 198B1A0459 | RENUMALA NAGAMUTTHU 18
53 198B1A0460 | SHAIK AZMAL 19
54 198B1A0461 | SHAIK SHAJAHAN 19
55 198B1A0462 | TELUKUTLA GOPI 19
56 198B1A0463 | THANNIRU DURGA MALLESHWAR )
57 198B1A0464 | VADDEMPUDI REVANTH 19
58 198B1A0465 | PULI JAYARAMIREDDY 19
59 | 208B5A0401 | KUNCHALA AKHILA 18
60 | 208B5A0402 | POTU SRI MOUNIKA 18
61 208B5A0403 | SYED TASNIMKAUSAR 17
62 208B5A0404 | VENNAPUSA ESWAR REDDY 19
63 | 208B5A0406 | TANNIRU MANOJ KUMAR 17

SN
Coordgator l-@AN '

HEAD OF THE DEPARTMENT
Department of EC.E

L RISE Krishna Sai Gandhi Group
of Institutions,VALLURU A P.-523 272



Certification Program Report on

“Antenna Design using HFSS”

Date:11-07-2022 to 15-07-2022

Introduction:

The Antenna Design using HFSS Certification Program, held from 11-07-2022 to 15-07-2022, was organized
under the visionary leadership of the Head of the Department, Mr. S.V. Ravi Kumar. The program aimed to
provide participants with an in-depth understanding of antenna design principles and hands-on experience with
the High-Frequency Structure Simulator (HFSS) software. Dr. K.V. Subrahmanyam, our esteemed Principal,

and Dr. P. Surendra Kumar, a distinguished resource person, played pivotal roles in ensuring the success of this

educational endeavor.

Syllabus covered:

1. Introduction to Antennas: The program commenced under the guidance of Dr. P. Surendra Kumar, whose
leadership set the tone for an exploration of fundamental antenna concepts. Participants delved into the
historical development of antennas, their role in communication systems, and various antenna
types.Antennas are fundamental components in the field of electromagnetic communication, serving as the
bridge between electronic devices and the surrounding electromagnetic environment. These devices play a
pivotal role in transmitting and receiving electromagnetic waves, enabling wireless communication across a
myriad of applications such as radio and television broadcasting, mobile communication, radar systems,
satellite communication, and more.

Historical Evolution: The history of antennas traces back to the late 19th century, coinciding with the
groundbreaking work of pioneers such as Heinrich Hertz and Guglielmo Marconi. Hertz's experiments with

radio waves and Marconi's subsequent development of practical wireless ¢ tion marked the advent

of antenna technology. Since then, antennas have e
advancements and the ever-expanding demands of mode
Basic Concepts: At its core, an antenna is a transducer that j}qupverts electrical signals into electromagnetic

waves for transmission or vice versa for reception. This proggssinvolves the manipulation of electric and

N



magnetic fields to generate a propagating electromagnetic wave. Key parameters such as frequency, gain,
polarization, and radiation pattern define the performance characteristics of an antenna.

a. Types of Antennas: Antennas come in various forms, each tailored to specific applications and
operating principles. Common types include dipole antennas, monopole antennas, patch
antennas, yagi-uda antennas, and parabolic antennas. The selection of an antenna type depends
on factors such as frequency range, directional requirements, and the overall communication
system's design goals.

b. Role in Communication Systems: In communication systems, antennas serve as the interface
between electronic circuits and the surrounding electromagnetic field. In transmission, an
electrical signal is applied to the antenna, converting it into an electromagnetic wave that
propagates through space to reach the intended receiver. In reception, the antenna captures
incoming electromagnetic waves, converting them back into electrical signals for further
processing.

¢. Parameters and Characteristics: Understanding and optimizing antenna parameters are
essential for efficient communication system design. Parameters such as impedance, bandwidth,
radiation pattern, and efficiency influence an antenna's performance. Engineers and designers
carefully consider these factors to achieve desired outcomes in terms of signal coverage, range,
and reliability.

d. Technological Advancements: Advancements in materials, design techniques, and
computational tools have significantly contributed to the evolution of antenna technology.
Computer-aided design (CAD) software, electromagnetic simulation tools, and advanced
manufacturing processes have empowered engineers to create antennas with enhanced
performance and reduced size, pushing the boundaries of what is achievable in modern
communication systems.

e. Future Trends: The evolution of antennas continues as we enter an era of pervasive
connectivity and the Internet of Things (loT). Miniaturization, multi-functionality, and
adaptability are becoming increasingly important. Antennas are expected to play a crucial role in
the development of 5G networks, smart cities, and emerging technologies, further shaping the
landscape of wireless communication.

2. Antenna Architecture: Antenna architecture encompasses the structural design and configuration of
antennas, defining their physical layout and arrangement of elements to achieve specific performance

goals. The choice of architecture is crucial as it direc

~influences the antenna's characteristics,

o=
including gain, directivity, bandwidth, and radiation ‘\@‘gﬂ!& ddleration, we delve into various
s

antenna architectures, their applications, and the considerations that guide their design.
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Dipole Antennas: Dipole antennas are one of the simplest and most widely used antenna
architectures. They consist of a conductive element, typically a straight wire or pair of wires,
with a voltage source applied across its ends. Dipole antennas radiate energy in a symmetric

pattern and are commonly used in radio and television broadcasting due to their omnidirectional
characteristics.

Eleetromagnetic Wave

MNE——>

Radio Recgiver
Monopole Antennas: A monopole antenna is a single, straight conductor mounted over a

ground plane. It is a half-wave dipole with one-half of the dipole element replaced by a ground
plane. Monopole antennas are extensively used in mobile communication devices, where their
compact size and omnidirectional radiation pattern make them suitable for various applications.
Patch Antennas: Patch antennas, also known as microstrip antennas, consist of a flat, metallic
patch mounted abovc a ground plane. They find widespread use in communication systems due
to their low profile, ease of integration, and suitability for planar and conformal applications.
Patch antennas are commonly employed in wireless communication systems, RFID, and satellite
communication.

Yagi-Uda Antennas: Yagi-Uda antennas are directional antennas consisting of multiple parallel
elements, including one driven element, a reflector, and one or more directors. This architecture
provides high gain and directivity, making Yagi-Uda antennas suitable for point-to-point
communication, such as in television reception and amateur radio.

Parabolic Antennas: Parabolic antennas utilize a parabolic reflector to focus incoming or
outgoing electromagnetic waves. The feed antenna, often located at the reflector's focal point,
provides a highly directional beam. Parabolic antennas are widely used in satellite
communication, radar systems, and point-to-point microwave links, where high gain and narrow

beamwidth are critical.

Horn Antennas: Horn antennas feature a flagd ws for a gradual transition

between the transmission line and free space. Th8§ are characterized by their wide bandwidth



and moderate gain. Horn antennas are employed in radar systems, satellite communication, and
microwave applications, where a balanced compromise between gain and bandwidth is required.
Log-Periodic Antennas: Log-periodic antennas consist of multiple dipole elements arranged in
a geometric pattern that repeats logarithmically. This architecture provides consistent
performance over a broad frequency range, making log-periodic antennas suitable for
applications requiring wideband coverage, such as in television broadcasting and

communication systems.

3. Considerations in Antenna Architecture:

a.

Frequency Range: The chosen architecture should be suitable for the frequency range of
interest.

Gain and Directivity: Different architectures offer varying levels of gain and directivity,
influencing the coverage and reach of the antenna.

Size and Form Factor: The physical size and form factor of antenna architecture are critical
considerations, especially in space-constrained environments.

Polarization: The desired polarization (e.g., vertical, horizontal) for communication needs
guides the selection of antenna architecture.

Environmental Factors: Considerations such as wind loading, temperature, and environmental

conditions impact the choice of antenna architecture.

As technology continues to advance, antenna architectures evolve to meet the demands of emerging

applications. The selection of the most suitable architecture involves a careful balance of

performance requirements, environmental considerations, and the specific needs of the

communication system in which the antenna is deployed.

4. Introduction to HFSS:

HFSS, or High-Frequency Structure Simulator, is powerful and versatile electromagnetic simulation

software developed by Ansys, Inc. It is widely used in the field of radio frequency (RF), microwave,

and high-speed digital design for simulating and analyzing electromagnetic fields. HFSS provides

engineers and designers with a comprehensive platform to model, simulate, and optimize complex

electromagnetic systems, including antennas, RF/microwave components, and integrated circuits.

5. Key Features and Capabilities:

a.

Full-wave Electromagnetic Simulation: HFSS employs a full-wave simulation approach,

solving Maxwell's equations to accurately model the behavior agnetic fields in

ailed and realistic f_epresentation of the

complex structures. This capability allows for a

physical phenomena involved in the design of high
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b. Broad Frequency Range: One of HFSS's strengths lies in its ability to handle a broad
frequency range, spanning from radio frequencies (RF) to microwave and millimeter-wave
frequencies. This makes it suitable for the design and analysis of a wide range of devices,
including antennas, filters, transmission lines, and resonators.

c. Parametric Analysis and Optimization: Engineers can perform parametric analysis and
optimization studies using HFSS. This functionality enables the exploration of design variations
and the optimization of parameters to achieve specific performance goals. It is particularly
useful for tuning antenna designs, matching network optimization, and fine-tuning
RF/microwave circuits.

d. Integration with CAD: HFSS seamlessly integrates with computer-aided design (CAD) tools,
allowing users to import complex 3D geometries and structures. This integration streamlines the
design workflow, making it easier for engineers to create accurate models and simulate realistic
scenarios.

e. Antenna Design and Analysis: HFSS is widely recognized for its capabilities in antenna design
“and analysis. Engineers can simulate various types of antennas, including wire antennas, patch
antennas, and reflector antennas, among others. The software provides insights into parameters
such as radiation patterns, gain, impedance matching, and efficiency.

f. High-Frequency Component Simulation: HFSS is instrumental in the simulation of high-
frequency components such as filters, couplers, and resonators. Engineers can analyze the
performance of these components in different frequency bands, taking into account the effects of
electromagnetic coupling, signal integrity, and impedance matching.

g. Finite Element Method (FEM) Solver: The software employs the finite element method
(FEM) as its underlying numerical technique for solving Maxwell's equations. This method
enables accurate modeling of complex geometries and material properties, making HFSS
suitable for a wide range of applications in electromagnetics.

h. Transient and Frequency-Domain Analysis: HFSS supports transient and frequency-domain
analyses, allowing engineers to study the time-dependent behavior of electromagnetic fields and
analyze frequency responses. This versatility is beneficial in understanding dynamic behaviors
and optimizing designs for various operational conditions.

6. Applications of HFSS:

a. Wireless Communication Systems: HFSS is widely used i

antennas for wireless communication systems, in

satellite communication.



b. RF and Microwave Circuits: Engineers leverage HFSS to simulate and optimize RF and
microwave circuits, such as filters, amplifiers, and matching networks, ensuring optimal
performance and reliability.

c. Radar Systems: HFSS plays a crucial role in the design and analysis of radar systems,
including the antennas and components used in radar transmitters and receivers.

d. Integrated Circuits (ICs): For high-speed digital design, HFSS aids in the simulation of signal
integrity, crosstalk, and electromagnetic interference in integrated circuits, ensuring robust
performance.

e. Medical Devices: In the medical field, HFSS is applied to model and analyze electromagnetic
interactions in devices such as MRI coils and biomedical sensors.HFSS is a comprehensive
electromagnetic simulation tool that empowers engineers to design and optimize high-frequency
components with confidence and precision. Its versatile features and broad application spectrum
make it an indispensable tool in industries ranging from telecommunications to aerospace and
beyond.

7. Antenna Parameters: Antennas are essential components in the field of wireless communication,
serving as the interface between electronic devices and the surrounding electromagnetic environment.
The performance of an antenna is characterized by various parameters that define its behavior and
effectiveness in transmitting or receiving electromagnetic waves. Understanding these parameters is
crucial for antenna design, optimization, and integration into communication systems. Here, we explore
key antenna parameters and their significance:

a. Radiation Pattern:

Definition: The radiation pattern of an antenna describes the distribution of radiated
electromagnetic energy in space.

Significance: It provides insights into how an antenna focuses or spreads its energy in different
directions. Common patterns include omnidirectional, directional, and sectorial, influencing
coverage and signal strength.

b. Gain:

Definition: Antenna gain measures the ability of an antenna to direct or concentrate radiated
power in a specific direction.
Significance: A higher gain indicates increased directional focus, enabling longer

communication range or improved signal strength in a particular direction. However, gain is

gee 7}
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often a trade-off with beam width and coverage.
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Directivity:

Definition: Directivity represents the concentration of radiated power in a particular direction,
often compared to an isotropic radiator (perfectly omnidirectional).

Significance: High directivity indicates a more focused radiation pattern, contributing to
increased gain in the desired direction.

Beam width:

Definition: Beam width is the angular width of the main lobe in the radiation pattern, measured
between points where the power is half the maximum.

Significance: Narrow beam width enhances directionality but may limit coverage. Broad beam
width is beneficial for omnidirectional coverage.

Polarization:

Definition: Polarization refers to the orientation of the electric field in the electromagnetic wave
radiated by the antenna.

Significance: Proper polarization alignment between transmitting and receiving antennas is

essential for efficient signal coupling. Common polarizations include vertical, horizontal, and

circular.

Impedance:

Definition: Antenna impedance represents the opposition to the flow of alternating current in
the antenna.

Significance: Matching antenna impedance with the transmission line or system impedance is
critical for minimizing signal reflections and maximizing power transfer

Bandwidth:

Definition: Bandwidth refers to the range of frequencies over which the antenna can operate
effectively, often defined by the frequency range where the gain falls within a specified
threshold.

Significance: A broader bandwidth allows the antenna to support a wider range of frequencies,
making it versatile in diverse communication environments.

Efficiency:

Definition: Efficiency quantifies how effectively the antenna converts input power into radiated

electromagnetic waves.

Significance: High efficiency ensures that a significant portion of the input power contributes to

useful radiation, minimizing power losses.
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10.

i. VSWR (Voltage Standing Wave Ratio):
Definition: VSWR measures the ratio of the maximum voltage to the minimum voltage in a
standing wave pattern along the transmission line.
Significance: A low VSWR indicates good impedance matching and minimal signal reflection,
optimizing power transfer.

Resonant Frequency:

ot o
.

Definition: Resonant frequency is the frequency at which an antenna exhibits maximum
efficiency and performance.

Significance: Operating an antenna at its resonant frequency enhances its effectiveness and
ensures optimal performance in a specific frequency band.

k. Front-to-Back Ratio:

Definition: The front-to-back ratio measures the relative strength of the radiation pattern in the
forward direction compared to the backward direction.
Significance: A higher front-to-back ratio is desirable for directional antennas, minimizing
interference from signals arriving from the rear.
Importance of HFSS with other Tools:
HFSS, as a high-fidelity electromagnetic simulation tool, plays a pivotal role in the design and analysis
of antennas, RF/microwave components, and other high-frequency structures. While HFSS is a
powerful standalone tool, its integration with other simulation and design tools enhances the overall
engineering workflow, providing a more comprehensive approach to solving complex electromagnetic
problems. Here's an exploration of the importance of HFSS in conjunction with other tools: .
Comprehensive Simulation Capabilities:

a. HFSS Strengths: HFSS excels in full-wave electromagnetic simulations, accurately capturing
complex electromagnetic phenomena.

b. Complementary Tools: Coupling HFSS with tools for structural, thermal, or fluid dynamics
simulations allows for comprehensive multi-physics analysis, ensuring a more realistic
representation of real-world scenarios.

Antenna Designing Mathematical Calculations: Dr. P. Surendra Kumar led participants through the

mathematical foundations of antenna design, including formulas for impedance matching, gain

calculations; and directivity. Real-world applications and case studies illustrated the practical

significance of mathematical calculations in the design process.
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11. Antenna Designing Procedures:

Antenna design with HFSS involves leveraging the software's capabilities for electromagnetic

simulation and optimization. Here's a step-by-step procedure for designing an antenna using HFSS:

a.

Define Design Requirements:

Clearly specify the purpose of the antenna (e.g., communication, radar, satellite).Identify key
specifications such as frequency range, gain, radiation pattern, and polarization.

Research and Choose Antenna Type:

Explore different antenna types suitable for the application. Use HFSS's knowledge base and
documentation to understand the strengths and limitations of various antenna types. Choose an
antenna type based on the research and requirements.

HFSS Project Setup:

Launch HFSS and set up a new project.Define project unit, frequency range, and other
simulation settings.

Geometry and Dimensions:

Create the 3D geometry of the antenna using HFSS's modeling tools. Input the calculated
dimensions based on the chosen antenna type and operating frequency.

Excitation and Boundary Conditions:

Define the feeding mechanism (e.g., port, waveguide) using HFSS's excitation features.Apply
appropriate boundary conditions to simulate the antenna's interaction with its surroundings.
Material Assignment:

Assign material properties to the antenna structure using HFSS's material library.Choose
materials based on their electromagnetic characteristics and environmental considerations.
Meshing:

Generate a mesh for the antenna geometry using HFSS's meshing tools. Adjust mesh parameters
to ensure accuracy and efficiency in the simulation.

Simulation:

Run a simulation to analyze the antenna's electromagnetic behavior. Examine key parameters
such as S-parameters, radiation pattern, gain, and impedance matching.

Optimization:

Utilize HFSS's optimization tools to improve antenna performance. Perform parametric sweeps
or use optimization algorithms to adjust,antenna parameters for optimal results Iteratively

simulate and optimize until the desired performance is
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Post-Processing and Visualization:

Analyze simulation results using HFSS's post-processing tools. Visualize radiation patterns, far-
field plots, and other relevant data. Evaluate performance metrics and compare with design
requirements.

Fabrication and Prototyping:

Use the optimized design parameters to fabricate a physical prototype. Verify dimensions and
configurations against the simulation results.

Validation and Testing:

Set up a testing environment consistent with real-world conditions. Measure key parameters
using testing equipment such as network analyzers and spectrum analyzers.Validate the

prototype's performance against simulation results.

. Fine-Tuning and Adjustment:

If necessary, make adjustments to the antenna based on testing results.Iterate between
simulation, fabrication, and testing to refine the design.

Documentation:

Document the final antenna design, including specifications, simulation results, and testing
outcomes. Create a comprehensive report that can be shared with stakeholders

Integration into System:

Integrate the designed antenna into the larger communication or electronic system. Verify
compatibility and performance in the system environment.

Field Deployment:

Conduct field tests to validate the antenna's performance in real-world conditions. Gather
feedback and make any necessary adjustments or improvements.

Maintenance and Optimization:

Develop a plan for long-term maintenance and potential future optimizations. Establish a
feedback loop for continuous improvement based on field performance and user feedback.By
following this comprehensive procedure, engineers can leverage HFSS's powerful simulation
and optimization capabilities to design antennas that meet or exceed performance requirements.
The iterative nature of the process, combined with the simulation tools provided by HFSS,

allows for efficient and effective antenna development.



12. Sample Antenna Design in HFSS:
Design Procedure using HFSS software:
a. Start ANSYS Electronics Desktop. Check (and change if necessary) that the working mode is
Driven Modal, HFSS > Solution Type > Modal.
b. Set Modeler length units to mm, Modeler > Units > mm.
¢. To draw a dipole element, select Draw > Cylinder and enter calculated values at radius and

height position
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d. After drawing the first element of the dipole we will create the second one by symmetry.
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xis, choose-the axis X

e. Select the first cylinder and then select Edit > Duplicate > Arou
or Y and enter the angle of 180°, Total number 2.

f. To provide an input source to perform the simulation. Select Draw > Rectangle and draw



arectangle (! it’s a surface model not a volume one) between the two wires, as in the figures

below.

B e&o

8%

it
- )
saigl geegt

i
‘;.
B

g. Select the drawn rectangle and define it as the input signal area/port HFSS > Excitations >

Assign > Lumped Port.




h. Select HFSS > Model > Create Open Region. Choose the frequency of
interest (around 900 MHz) and Radiation boundary.
i. Add asolution. Select HFSS > Analysis Setup > Add Solution Setup
j. After meshing, we define a broadband analysis. Select the previously
defined solution (Project Manager > Analysis > Setupl) and add a
broadband solution around the frequency corresponding to the single
frequency solution HFSS > Analysis Setup > Add Frequency Sweep.
k. Select HFSS > Validation Check to verify that all required steps have been
completed.
1. Select HFSS > Analyze All to start the simulation. Click the Show Progress
button to view the progress of the solver.
m. Select HFSS > Results > Create Modal Solution Data Report > Rectangular
Plot to display the S parameter corresponding to input port P1 (in dB).
n. Similarly plot far-fields parameters of the antenna.
Dr. P. Surendra Kumar demonstrated the practical application of knowledge through a sample
antenna design using HFSS. Participants engaged in hands-on exercises, applying concepts
learned during the program. The Q&A session facilitated direct interaction, allowing participants
to seek clarification on specific design aspects.
Result Analysis: The critical aspect of interpreting simulation results. Participants acquired the
skills to analyze and compare simulated results with theoretical expectations. lterative design
refinement based on result analysis was emphasized.
Certificate Program Exam: The program concluded with a comprehensive exam under the
guidance of Mr. S.V. Ravi Kumar. The exam evaluated participants on theoretical knowledge
and practical skills, covering topics from the entire program. The assessment aimed to certify
participants based on their understanding and application of the concepts learned.
Vote of Thanks: We extend our sincere gratitude to Mr. S.V. Ravi Kumar, Head of the
Department, for his visionary leadership, Dr. K.V. Subrahmanyam, Principal, for his unwavering
support, and Dr. P. Surendra Kumar, the esteemed resource person, for their invaluable
contributions to the success of the Antenna Design using HFSS Certification Program. Your

guidance and mentorship have been instrumental in shaping the learning experience for all

participants.
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